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One Year Limited Warranty

★★★★★

Ultra★Stereo Labs, Inc. warrants that each product manufactured
by it will be free from defects in material and workmanship under
normal usage for a period of one (1) year after its purchase new
from an authorized dealer. Our obligation under this warranty is lim-
ited to repairing or replacing any product or component which we
are satisfied does not conform with the foregoing warranty and which
is returned to our factory, freight paid, or serviced by one of our
authorized contractors. The foregoing warranty is exclusive and in
lieu of all other warranties, whether expressed or implied. Such war-
ranty shall not apply to any product or component (A) repaired or
altered by anyone other than Ultra★Stereo Labs or an authorized
service contractor; (B) tampered with or altered in any way or sub-
jected to misuse, negligence or accident or (C) which has been im-
properly connected, installed or adjusted other than in accordance
with Ultra★Stereo Labs instruction.
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Review the following safety precautions to
avoid injury and prevent damage to this
product. To avoid potential risk, use this
product only as specified and only for the
purpose described in the instruction
manual.

To Avoid Fire and Personal Injury:
• Use Correct Power Cable. Use only the power cable

provided. Ensure that the AC power outlet is located
near the product and is easily accessible.

• Use a Correctly Grounded Power Source. The
Power Supply earth ground is established through
the ground conductor in the power cable. To avoid
the potential of electric shock, the ground conduc-
tor must be correct.

• Observe Source Ratings. To avoid risk of fire or elec-
tric shock, the power source must be 110 - 240VAC,
50-60 Hz

• Do Not Operate this Product with Any Covers
Opened or Removed.

• Avoid Exposed Circuitry. Do not attempt to open
the Power Supply as its safety certification would
be invalidated. The Power Supply is a non-repair-
able sealed device.

• Do Not Operate with Suspected Failures. If you sus-
pect there is damage or malfunction with this prod-
uct, call the factory.

• Do Not Attempt Repair. Only a trained factory ser-
vice person is authorized to repair this product.

• Do Not Operate this Product Near Heat Sources.
This product should not be located near heat
sources such as radiators, heat registers, stoves, or
other high temperature sources.

• Provide Proper Ventilation. The operating tempera-
ture should be between 0° C and 50° C. The humid-
ity should be <90% at +40° C or below and <60% at
41° C to 50° C. The cooling method is by convec-
tion.

• Keep Product Surfaces Clean and Dry. Disconnect
the power cable from the power source before clean-
ing. Do not use liquid cleaners or aerosol cleaners.
Use a damp cloth for cleaning the outside of cam-
era. Use lens cloth for lens cleaning.

• Do Not Push Objects Into Opening of this Product.
Never insert objects into the product through open-
ings.

• Do Not Operate In Wet or Damp Conditions.

• Do Not Operate In an Explosive Atmosphere.

• Prevent the Spilling of Liquids onto the System
Components.

• Inspect the Power Cable and All Cables Prior to
Use. Confirm that the power cable and other inter-
connecting cables are free from damage.

• Be Especially Alert When Setting Up Product in
Theaters. Establish adequate light. Position cables
to avoid trip dangers. The tripod and camera box
should be carefully and securely attached to each
other. The tripod leg angles should be fully extended
outwardly in three directions for maximum stabil-
ity. The leg length extensions can be varied to ac-
commodate the inclination of the theater flooring.

General Safety Summary
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The USL, Inc. Projection System Analyzer
200 (PSA-200) is an advanced system for
aligning and analyzing motion picture pro-
jection systems.
The PSA-200 is a portable system that
comes in a single, high-quality carrying
case. The system primarily consists of a
specialized TV camera, a Video Interface
PCMCIA card (PC Card), and custom soft-
ware. It is designed for use with a laptop
PC operating with Windows 95 or 98. The
software is very easy to use.
The PSA-200 greatly improves the quality
of projection system alignment and signifi-
cantly reduces the time and effort involved.
The PSA-200 displays the luminance values
for every part of the screen. It also indicates
and accentuates variations in screen bright-
ness by shading of the laptop display. An
optional feature also allows analysis and
reporting of the weave, jitter and flicker
components of the projected image. The
PSA-200 can also be used as a spot meter.
The standard luminance range is from three
to 30 foot-Lamberts (10-100 candelas/
square meter). With the addition of an op-
tional ND1 neutral density filter, the range
can be changed to 30 to 300 foot-Lamberts
.
All information measured and displayed can
be saved in a report file suitable for hardcopy
print out. A listing of all equipment for each
theatre auditorium can be entered into the
report along with any pertinent comments.
The report files can be exported to a spread-
sheet program such as Microsoft Excel. This
makes the measurement data available for
analysis of equipment performance and
experimental results.

PSA COMPONENT LIST

Camera (PS2-CA2, 48Hz two-blade shutter
or PS2-CA23, 72Hz three-blade shutter)

Tripod (PS2-TR1)

Case (PS2-CC)

75-foot camera cable (PS2-C75)

Proprietary Video Interface PCMCIA Card
(PS2-VC1)

“Y” Cable (PS2-JY), connects power to
PCMCIA card and camera cable

Power adapter 110V-240V (PS2-UP)

Power Cord (US: PC-USA, European: PC-
EUR, Australian: PC-AUS)

Software diskettes/CD ROM

Manual

OPTIONS

Weave and Jitter Software Upgrade (PS2-
FWJ), includes RP-40 Test Film (SMPTE-
35PA)

10-foot camera cable (PS2-C10), for use in
projection booth.

Neutral Density Filter (PS2-ND1) 30-300
foot-Lamberts luminance range.

72 Hz, three-blade shutter after-purchase
upgrade (PS2-3BS0)

INTRODUCTION
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Camera

Camera Cable

Test Film
(Optional)

Power Adaptor

Y Adaptor
and Cable

Power
Connector

Software

PSA-200
Laptop Software
Windows 95/98

Version 0.23
Copyright USL, Inc. 1999

INSTALL DISK ONLY

PSA SERIAL #

User’s Laptop

Video Interface
PC Card

Tripod

CD ROM

PSA-200 Component Identification
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IMPORTANT! The software must be in-
stalled in the laptop computer before
the PC Card is inserted into the com-
puter.

WARNING TO OWNERS OF MORE THAN
ONE PSA-200 SYSTEM

The PSA-200 software contains calibration
information. This information is matched to
the hardware of the same serial number. For
this reason, using the hardware from one
system with the software from another will
result in a loss of accuracy. Measurements
obtained in this way are not guaranteed to
be within specifications. It is recommended
that users of multiple systems label the “tar-
get” and “program” directories by the se-
rial number when installing them and run
the software corresponding to the hardware
being used.

Software Installation
The software is compatible with Windows
95, and Windows 98.
If this is the first time you are using the PSA-
200, you need to install the software on your
laptop computer. There are two steps re-
quired to install the operating software. The
first is to install the PSA-200 application
program; the second installs the drivers for
the PCMCIA video card.

PSA 200-Application Installation:

1. Insert the floppy disk, labeled PSA200
application into the floppy drive.

2. Click on the Start button then click on
the run icon. The “Run Dialog” box
will appear.

3. Type in “a:/setup.exe” Then click on
OK; a welcome box will then appear.

4. Click install. A “Target Directory” dia-
log box will appear, along with the
name of the directory where the PSA-
200 program will reside. The default
directory is c:\PSA.

5. Click on OK. A “Program Group” box
will appear, along with the name of the
program group, which will hold the
icons for the PSA-200 program.

6. Click on OK. An “Installation Com-
pleted” box will appear.

7. Click on OK. A window containing the
PSA-200 shortcut icon and the
uninstaller icon (used to remove the
PSA-200 program from your laptop
computer) will appear. (The PSA short-
cut icon can be moved on to the desk-
top now.)

8. Remove the floppy disk.

PCMCIA Driver Installation. Do Not Insert
PC Card.

1. Insert the CD ROM labeled PSA 200
Install into the CD ROM drive.

2. Click on “My Computer” on the win-
dows desktop. Then click on the CD
ROM icon.

3. The “Vppro95” folder will appear. Click
on the Vppro95 folder to open it.

4. There are three setup icons. Double
click on the setup icon showing a com-
puter with an open box and disk to
begin the driver install process.

5. Enter your name and company in the
Registration dialog box that appears
and click on “Next.”

6. A registration Confirmation dialog box
will appear, click “Next.”

7. The destination dialog box will appear.
Click next to install the driver files in
the default location.

8. The “Setup Type” dialog box will ap-
pear. Select the Custom button and
click “Next.”

SETUP PROCEDURE
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9. A group of check box options will ap-
pear. Deselect all but the following
three boxes: Window 95 Device Driver,
MRT Video for Window Driver, and
MRT MCI Driver. Then click “Next.”

10. Verify information in the next two con-
firmation windows to complete the in-
stallation.

11. You must reboot the computer before
the driver settings take effect.

Hardware Setup
The laptop computer, the Video Interface
PCMCIA card and the Power Adapter are
usually set up in the projection booth of the
theater, while the camera may be set up in
either the auditorium or the projection
booth. If the camera is set up in the center
of the auditorium, the camera sees the
movie screen exactly as the audience does.
(The PSA-200 camera should be positioned
at least one screen width back from the
screen.) If the camera is set up in the pro-
jection booth, looking through the projec-
tion port, compensation for the vertical
angle-of-view can be made in the software
(see page 15).
NOTE: The software must be installed be-
fore the PC Card is inserted into the laptop
computer.
NOTE: The Power Adapter will accept any
50 or 60 Hz power source from 100 to 240
VAC. The power cord itself is specific to the
region and type of outlet connector.

1. The power cord of the power adapter
should be disconnected during hard-
ware set-up.

2. Mount the camera on the tripod and
set it either in the center of the audi-
torium or in the projection booth.

3. Connect the flat AMP connector into
the PC Card, being careful that small
hooks on either side engage the PC
card Frame and the AMP logo is fac-
ing up.

4. Insert the PC card into the PCMCIA (PC
Card) slot of the laptop computer (as-
suming that the software has already
been installed in the laptop)

5. Connect the camera cable to the cam-
era and to the circular, nickel-plated
connector of the “Y” cable.

6. Connect the female DC output connec-
tor of the power supply to the male
connector of the “Y” cable.

7. Connect the AC power cord of the
Power Adapter to the Power Adapter
and to an AC outlet.

8. Remove the lens cap from the camera
lens, orient the camera and adjust the
zoom control at the rear of the cam-
era (see Fig. 1) so that the movie
screen fills about 90% of the camera
viewfinder screen and is centered. (It
may be necessary to turn on the pro-
jection lamp to provide adequate light
for the camera positioning and zoom
adjustment.)

ZOOM

POWERCAMERA

OUT IN

(Fig. 1) Viewfinder Display
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9. Turn on the laptop computer.

10. Access the PSA.exe program on the
laptop computer. The laptop com-
puter display should show a 9 by 5 grid
of luminance values (see Fig. 2). Across
the top will be a toolbar with function
key buttons which access various PSA-
200 functions.

(Fig. 2)  Luminance Grid (9x5)

NOTE: If the camera is not connected or the
PC card is not responding, an error message
will be displayed. (See Troubleshooting sec-
tion.)

11. Turn the projector on with no film in-
serted. Turn the projection lamp on.
Open the dowser to illuminate the
screen. WARNING: Do not leave the
dowser open for more than one (1)
minute. Heat from the projection lamp
light can damage the projector lens.

12. Press or click on F3, Camera View. The
display should show the movie screen
as seen by the camera (see Fig. 3). It
should look centered on the laptop
computer screen. The image of the
movie screen should fill about 90% of
the laptop computer screen and all
edges of the movie screen should be
visible, along with a darker border
around the edges. If no border is vis-
ible, zoom out until the movie screen’s
border appears. You can use the zoom
control on the camera or the zoom

control on the laptop computer (Cam-
era View [F3]) screen, whichever is
more convenient.

(Fig. 3) Camera View

13. Press or click on F2, Auto Align. This
function automatically senses the
edges of the movie screen image. It
creates an artificial border for the lu-
minance measurements. This border
is a rectangle inset from the screen
edges by 5% of the screen dimensions.
All screen luminance measurements
are made within this border.

14. Press or click on F4, Luminance. The
displayed grid will now show the ac-
tual luminance readings for each of the
45 zones of the grid (Fig.2). The shad-
ing of each zone should show the rela-
tive brightness with respect to the
other zones, giving a good display of
the light pattern for ease of lamp house
adjustment.

NOTE: The PSA-200 and laptop computer
require a warm-up period of at least two
minutes before measurement readings are
accurate.
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side the image and not in the darker bor-
der surrounding it in order for a manual
alignment border to work.

Artificial
Border

Screen
Edge

(Fig. 4) Manual Alignment

Measuring Luminance

First, use the Automatic or Manual Alignment
function. Next, press or click on F4, Lumi-
nance. The PSA-200 software breaks down the
luminance of the projection screen into 45 (9
X 5) zones (see Fig. 2). A separate luminance
value is measured and displayed for each
zone. Each of these luminance values is an
average of 10 separate measurements taken
at different places in that zone. The shading
of each zone shows the relative luminance
with respect to the other zones, giving a good
display of the light pattern for ease of lamp-
house adjustment. Zones are numbered, left
to right, starting from the top, for reference.
The status bar (located at the bottom of the
screen) displays the zone that the mouse
pointer is in, along with the average lumi-
nance and the center zone’s luminance.

Using the Spot Meter

The Spot Meter function is useful in taking
measurements of ambient light, reflected light
and lens flare. While in Camera View (F3) or
Luminance (F4), press or click on F6, Spot
Meter. Use the mouse to move to any part of
the area being analyzed and the luminance
value displays in the status bar at the bottom
of the screen, along with the center luminance
and the number of the zone the Spot Meter is
in (see Fig. 5).

OPERATION

This section describes the operation of the
PSA-200 in detail. It is organized by specific
activity for easy reference. These activities
appear in the usual order they are per-
formed when using the PSA-200.

Automatic Alignment

Manually adjust the camera angle and the
camera zoom switch so that the theater
screen appears centered in the camera’s
viewfinder (see Fig. 3). Press or click on F3,
Camera View. The image should appear cen-
tered in the laptop computer display. Ad-
just the zoom control so that the edges of
the screen are visible in the laptop com-
puter display. Now press or click on F2, Auto
Align. The PSA-200 software will automati-
cally sense the edges of the movie screen
image and create an artificial border for the
luminance measurements. This border is a
rectangle inset from the screen edges by 5%
of the screen dimensions. All screen lumi-
nance measurements are made within this
border. NOTE: The Camera View, Luminance
and Spot Meter are the only functions that
use the alignment border.

Manual Alignment

In rare instances, when the lamphouse is
severely misaligned, the automatic align-
ment software will not be able to locate the
screen edges. In this case, the manual align-
ment function must be selected. This func-
tion allows the user to manually set the
borders of the screen area to be analyzed.
First, press or click on F3, “Camera View,”
then click on the “Alignment” menu, then
on “Manual.” Position the mouse pointer on
the top-left corner of the desired area, then
click and drag the mouse pointer to the
bottom-right corner of the area and click
again. The manual alignment border and the
previous alignment border will both remain
on the screen. Now select “Camera View”
again. A single alignment border, represent-
ing the manual alignment, should be present
on the screen (see Fig. 4). The manual align-
ment border that is produced must lie in-



Page 112nd Edition. January, 2000 ULTRA★STEREO PSA-200 Instruction Manual

(Fig. 5) Spot Meter

Checking Weave and Jitter
(Optional Feature)

The PSA-200 measures picture steadiness
in terms of Weave and Jitter (or Jump).
Weave is the residual horizontal motion of
a projected image. Jitter is the residual ver-
tical motion of the image. The software uses
the image of the SMPTE test film RP 40 for
calibration and measurements. (For infor-
mation on measurements and acceptable
values, please refer to SMPTE Recom-
mended Practice # RP1-5-1995. The width
of one square on the test pattern represents
0.5% weave. The vertical dimension of a
square represents 0.94% jitter when the as-
pect ratio is 1.85 to 1.)

Procedure

1. Run a copy of the SMPTE-35PA/RP40
test film in the projector. (If a film loop
is used, make the loop as long as is
practical). Make sure that the projec-
tor lens is properly focused. Be sure
to have the appropriate screen aspect
ratio present in the Program Setup box
(Settings menu).

2. Press or click on F3, Camera View.
Make sure that the RP40 test image is
centered in the Camera View presen-
tation (see Fig. 6).

(Fig. 6) SMPTE Test Pattern

3. Use the Camera View [F3] zoom con-
trol to zoom in on the image until the
wide white bar in the center of the
frame approximately fills the Camera
View in the horizontal direction. (See
Fig. 7.)

(Fig. 7) SMPTE Test Pattern



Page 12ULTRA★STEREO  PSA-200 Instruction Manual 2nd Edition. January, 2000

4. Press or click on F7 (Weave and Jitter).
Press or click on F3 again. A red square
should appear in the lower left part of
the screen. This indicates the area that
is being analyzed by the software.
Check and ensure that this area en-
closes only the black and white
squares part of the image and does not
overlap any of the white portion. The
software uses the black and white
squares of the image for the calibra-
tion and measurements.

5. Press or click on F7 again. This will
initiate the weave and jitter measure-
ments. After approximately 10 to 20
seconds, the display should appear
and present the initial readings. (See
Fig. 8) The graphs display amplitude
vs. frequency of the spectral compo-
nents as a troubleshooting aid. As the
PSA-200 analyzes the image motion
and accumulates more data, the accu-
racy of the readings increases. After
approximately two minutes, the soft-
ware will have completed the analysis
and will present figures that are quite
accurate.

6. Press or click on the Save bar at the
upper right of the screen to save the
figures to the report.

(Fig. 8) Weave

Checking Flicker (Optional Feature)

Press or click on F8, Flicker (see Fig. 9). This
function displays the flicker as a percent-
age of the amplitude of the desired compo-
nent (the 48 or 72 light pulses per second
component). The graph displays the fre-
quency and amplitude of the flicker com-
ponents as a troubleshooting aid.

(Fig. 9) Flicker
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Report Function
This function allows all measurement data
and equipment configuration to be summa-
rized in a concise report suitable for print-
ing or exporting to a database.

Saving Data to the Report

Luminance and other data can be saved to
the report. Select the function to be saved
so that the data shows on the screen, then
press the S key on the keyboard or click on
the Save button on the toolbar. You can also
select “Save” from the “View” menu to save
data to the report. To overwrite existing
data on the report, select the desired func-
tion and save it to the report. The old data
for that function will be replaced with the
new data.

Adding Text to a Report

Once data has been saved to a report, text
information about the equipment and the
measurements can be added. First, press or
click on F9, “Report,” to view the saved data
(see Fig. 10). Press or click again on F9, “Re-
port,” again to bring up the “Report Edit”
dialog box (see Fig.11). Press the tab key to
scroll through the different text entry blocks
or click on the desired text entry block with
the mouse, then enter the text. When you
are finished, press the enter key or click on
the OK button.
The Clear Data button deletes all of the text
of the report. The Cancel button deletes all
of the text of the report and returns to the
PSA-200 report screen.

(Fig. 10a) Report - Top

(Fig. 10b) Report - Bottom

(Fig. 11) Report Edit
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Deleting all Data and Text from a Report

To delete all data from the report, includ-
ing text, select “New” from the File menu. A
message will appear which asks whether
you want to save the changes made to the
report. Selecting “Yes” will bring up the
“Save As” dialog box, enabling you to save
the current report before going to a new,
blank report. Selecting “No” will delete all
report contents.

Saving a Report to a File

Select “Save As” from the File menu. Enter
a name for the file. Select the drive and di-
rectory. Press the enter key or click on the
OK button .

Printing a Report

Select “Print” from the File menu. A print
dialog box will appear. Press the enter key
or click on the OK button.

Viewing a Saved Report file

The PSA-200 program must be running in
order to view a report. Select “Open” from
the File menu. Select the file name and press
the enter key or click on the OK button.

Deleting a Previously Saved Report

First, exit the PSA-200 program. Using My
Computer or Windows Explorer for Win-
dows 95 and 98, double-click on the drive
where the PSA-200 files are stored. Double-
click on the PSA-200 folder or other direc-
tory and folder (where files are saved). Se-
lect the .rpt file to be deleted, then press
the Delete key or select File, then “Delete.”
WARNING: Care should be taken to insure
that only the intended files are selected for
deletion.

Creating a Report with the same (or
similar) file name as a previously saved
report

Select “Open” from the File menu. Choose
the previously saved file and click on OK.
Save the new data to the report, then make
any necessary changes in the text. Select
“Save As” from the File menu. Enter the file
name for the new report, then click on OK.

Creating Multiple Reports with the same
(or similar) file name

After saving the first report, be sure not to
select “New” from the File menu (this clears
the report contents but does not delete the
last saved report file). Instead, save the new
data onto the first report and make any nec-
essary changes in the text. Select “Save As”
from the File menu. Enter the new file name,
then click on OK. (Entering the same name
as the first report instead of a new one at
this point will overwrite the first report.)

Menu Bar
File

This menu includes all the standard func-
tions as well as two specialized ones to al-
low the export of report information.

Settings

This menu allows choice of options for
three sections of the software, Program,
Export and Authorization.
Under Program, optional settings for the
display and measurements are established
(see page 15).
The Export section provides options for the
export format of the report functions.
The Authorization function allows the up-
grading of software in the field. The user
enters an authorization code (provided by
contacting USL) into the dialog box to imple-
ment software upgrades.

Alignment

Refer to page 10.

View

This menu feature allows the selection of
each of the main functions of the PSA-200.
It also provides an alternate way of saving
data on the screen to the report.

Report

This menu item selects the Report function.

Help

This item displays the PSA serial number,
and the software version number. The Help
portion has not yet been implemented.
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Program
The Program section controls values for the
display and measurement functions (see
Fig. 12).

(Fig. 12) Program Setup

Display

Five shades of gray are used to show bright-
ness differences among the zone squares.
The “foot-Lamberts per gray step” value
sets the number of foot-Lamberts variation
between steps or displayed shades of gray.
A value of one is the default value and is
proper for most applications.
“Fit display contrast to image contrast”:
This asks the software to maximize the con-
trast of the display and to have it follow the
camera video closely. This is normally
checked.

Weave and Jitter

If the Weave and Jitter option is included
and such measurements are to be made, the
screen aspect ratio should be inserted here.
Correct calculation of the results is depen-
dant upon the aspect ratio.

Luminance

This section allows choice of display win-
dow type, either 9x5=45 zones (see Fig. 13)
or 3x3=9 zones (see Fig. 14). In the 9x5 dis-
play, the luminance value is displayed for
each zone. In the 3x3 display, the luminance
value for the center zone is displayed and
the rest of the zones show the luminance
value as a percentage of the center value
reading.

(Fig. 13) Luminance Grid 9x5

(Fig. 14) Luminance Grid 3x3

A check box is provided for the choice of
luminance data being displayed rapidly as
measured or after filtering. The filtered data
is updated more slowly and is easier to read.

Camera

This section sets the measurement range
of the camera and display. It also will ad-
just the data to compensate for the vertical
angle-of-view when the camera is positioned
in the projection booth.
The nominal measurement range of the PSA-
200 is three to 30 foot-Lamberts. With the
addition of an optional ND1 neutral density
filter, the range can be changed to 30 to 300
foot-Lamberts. The PSA camera is normally
set to read luminance in the audience area.
If the camera is situated in the projection
booth, there is a vertical angle between the
audience view of the screen and the view
from the projection booth. This causes the
apparent centering of the light pattern on
the screen to move upward. If this apparent
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centering error is not corrected, the
lamphouse adjustments will be in error. The
selection box in this section allows you to
input the approximate vertical angle be-
tween the audience view and the projection
booth view so that the error can be com-
pensated. The precise angle does not have
to be measured. If the angle that is esti-
mated and entered is within five or 10 de-
grees of the actual value, the vertical cen-
tering will be within a few percent.

Units

This section provides a choice between
English and metric units of luminance.

Export Features
This software version has new single and
multiple report file handling features which
includes the capability of combining previ-
ously saved report files and storing such
combined files in an export format (suitable
for import into spreadsheet programs such
as MS-Excel). This file handling feature
couples the PSA-200 cinema analyzer to the
power and utility inherent in database
analysis.

(Fig. 15) Settings & Export

Export Features

• Maximum number of report files selectable
for export (at one time) is now 3000.

• “Save As” recognizes numeric file names
and auto-increments each new file.

• Report displays pop up with luminance val-
ues centered on screen.

• Database file export now has its own setup
screen under Settings (see Fig. 15 and Fig.
16). Options are explained in the order that
they appear on the screen.

File Type
“Export multiple reports to single data-

base file.”
Collects all data from selected report

“.rpt” files for inclusion in to a
single export “.csv” file. Single
report format is the default.

Export Format
“All information formatted on a single

row.”
Everything laid out in cells on a

horizontal row.
“Insert luminance information in a single

row.”
Lays out data in a row of 45 cells

(instead of 9 x 5 cell matrix).
“Insert field names in database.”

Includes field names in database cell
structure.

Field to Export
“Report header (theater, screen, etc.).”

Data/information in these fields can
be included or excluded.

“Luminance”
Luminance data values can be in-

cluded or excluded.
“Equipment information (projector,

screen, etc.)”
Data/information in these fields can

be included or excluded.
“Comment”

Information in comment section can
be included or excluded.
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(Fig. 16) Export Settings

Specifications

1. Laptop Operating System Require-
ments: Windows 95 or 98

2. Case Size: 21" x 13.5" x 7" (53cm x 34cm
x 18cm)

3. Weight: 19.5 lb (8.8 kg)

4. Power Requirements: 100 to 240VAC,
50 to 60 Hz at .07A (8.5W)

5. Luminance Measurement Range: three
to 30 foot-Lamberts (10-100cd/m)

Optionally 30 to 300 foot-Lamberts
(100-1000cd/m)

6. Luminance Measurement Accuracy:
±5%, ±2 digits

7. Spot Meter Acceptance Angle: approxi-
mately 1° when camera is 1.5 screen-
widths distant from the movie screen,
and the screen image fills approxi-
mately 90% of the camera’s horizon-
tal image area.

8. Spot Meter Accuracy: ±5%, ±2 digits

9. Weave, Jitter and Flicker Measure-
ments Accuracy: ±10% of reading

10. Weave, Jitter and Flicker Measure-
ments Resolution: .05%

11. Environment: Temperature 40°-110° F,
Humidity 10% to 90% non-condensing
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PSA-200 Block Diagram

Camera Board
PS2-K10

Modified Camera Assy.
PS2-MCA

CCD

J2 J3

Zoom
Lens

Converter
Lens

Viewfinder
PS2-V10

J1 J4

Camera Assembly
PS2-CA2/23

”Y” Cable
PS2-JY

Camera Cable
PS2-C75

Laptop
PC

PCMCIA
PS2-VC1

Power
Adaptor
PS2-UP
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Troubleshooting The PSA-200

Software
Should you receive an error message such
as “Video capture card not responding” or
encounter problems with the PSA-200
PCMCIA card, please refer to the following
troubleshooting instructions:

The changes that are listed should not
affect any other components of your
system. If at any time you are uncom-
fortable changing your computer’s
configurations, and would like some
guidance, please call USL, Inc. for tech-
nical support at 805-549-0161.
Please be advised that there is a known
conflict between the PSA-200 Video Cap-
ture card and some network interface
cards. It is recommended to check for IRQ
or memory allocation conflicts or to re-
move any network interface cards from
the “Device Manager’ if a problem occurs
during the installation or operation of the
PSA-200 system.

1. Verify you have installed the PSA-200
software before you inserted the
PCMCIA card. If you did not, proceed
to step 4.

2. Be sure that the card is properly in-
serted in the PC Card socket. Eject the
card and insert it again.

3. Ensure that all cables are correctly
connected together. Check that all con-
nectors are fully inserted, and latched,
if applicable, to their mating parts.

4. Check to make sure the PCMCIA card
is correctly initializing.
A. Right click the “My Computer”

icon and select “Properties” from
bottom of list.

B. Click the “Device Manager” tab at
the top of the System properties
dialog box.

C. Scroll down to “Sound, video and
game controllers” and double
click to expand

D. Double click “Video Port Profes-
sional” icon on the device list
(see Fig. 17).

Fig. 17

E. In the Device Status field it
should say “This device is work-
ing properly.” (See Fig. 18)
If not, select/highlight “Video
Port Professional” icon in previ-
ous window and click “Remove.”
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Fig. 18

F. Shutdown the system and remove
the PCMCIA card. Never remove
the PCMCIA card without first
shutting down the system or by
using the stop communication
button through the PCMCIA
control panel first.

G. Restart the system.
H. After your computer has com-

pletely rebooted, insert the PSA-
200 software diskette into your
floppy drive.

I. Double click the “My Computer”
icon.

J. Double click the “Floppy drive A:”
icon.

K. Double click the “Setup” icon and
follow the installation instruc-
tions.

L. Restart the system.
M. After your computer has com-

pletely rebooted, insert the
PCMCIA card and wait for the
new hardware to install

N. Hookup the PSA-200 camera and

power, and launch the PSA soft-
ware.

The PSA-200 should now work prop-
erly, if not:

5. Make sure the Windows operating sys-
tem is located in C:\Windows and the
USL support files are as follows:
The “Ms80x.inf” driver is in the
“C:\Windows\Inf” folder.
The “Ms80x.vxd” is in the
“C:\Windows\System” folder.
The “Ms80x.vxd” file might be hid-
den in your “C:\Windows\System”
folder.
To configure your system to show
this file you must:
A. Double click on the “My Com-

puter” icon.
B. Choose “View” from the menu at

the top of that window and click
on “Options” at the bottom of
that list.

C. Click on the “View” tab and
choose the “Show all files” option
(see Fig. 19). Click OK.

Fig. 19
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D. Return to the
“C:\Windows\System” folder, and
check for the “Ms80x.vxd” file.

If either of the two files specified are not
listed, manually copy the files from the
floppy to the appropriate directories and
proceed back to step 3.
If the above steps have not resolved the
problem, then proceed to step 6.

6. Check your “Card Services Software”.
If Card services or another third party
PCMCIA slot manager is present, the
PSA-200 capture card may have prob-
lems being identified by the Windows
operating system. The PSA-200 Video
Capture Card as been designed to
work in the “Plug and Play” card driver
mode. Laptops configured with Win95
or Win98 plug and play, 32bit mode will
not have this problem. Card Soft is the
most common of these PCMCIA man-
agers. The example below describes
how to remove the “Card Soft” card
driver mode. To change the Card
Driver mode:
A. Insert the PSA-200 Video Capture

Card.
B. Open the PCMCIA slot controller

software by double clicking on
the PCMCIA icon usually located
in the icon tray at the lower right
corner of your desktop or open
the “CardWizard” software from
your “Start Menu”.

C. Find “VideoPort Professional 5/2
MRT” on the list of cards in-
stalled.

D. If the card ID has a question mark
(?), then the software must be
changed (see Fig. 20).

E. Right click on the box onscreen
where it says “VideoPort Profes-
sional 5/2 MRT” and choose
properties.

Fig. 20

F. Choose the “Drivers” tab and
click on the boxes for:
1. “Change Card Driver”
2. “Use Plug and Play”

(See Fig. 21)
Click OK

Fig. 21

G. From this point the computer will
search for a driver and might not
find one. Put the PSA installation
disk in the “A” drive and use the
“Browse” button to choose the
“A” drive location. The computer
will find the file “Ms80x.vxd” and
place it into the proper location.

H. Remove the PSA-200 PCMCIA
card from the slot. Never remove
the PCMCIA card without first
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shutting down the system or by
using the stop communication
button through the PCMCIA
control panel first.

I. Re-insert the PSA-200 PCMCIA
card and confirm the driver
information by opening CardSoft.
The screen should no longer have
the question mark and the driver
will be properly identified (see
Fig. 22).

Fig. 22

7. Check the PCMCIA socket controller.
This is the hardware that controls your
PCMCIA slot. Some laptops also use a
socket controller from a manufacturer
other than Windows. The PSA-200
needs the generic Windows socket
controller. To check your PCMCIA
socket controller:
A. Enter into the “System” window

from the “Control Panel”. Choose
the “Device Manager” tab.

B. Scroll down to “PCMCIA socket”
and double click to expand.

C. The entry under this heading
should be “PCIC or compatible
PCMCIA controller.” (See Fig. 23)

Fig. 23

D. If not, double click on the entry
that is currently configured, and
under the “General” tab choose
“Disable in this hardware profile”.
Do not “remove” it (see Fig. 24).
Click OK.

Fig. 24

E. Windows will prompt you to
reboot your system, answer
“Yes.”
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F. After your system has completely
rebooted, enter back into the
“Control Panel” and click on “Add
New Hardware.”

G. Windows will prompt: “To begin
installing your new hardware,
click “Next.”

H. You will be asked: “Do you want
Windows to search for your new
hardware?” Select “No” and click
“Next.”

I. Now you will be prompted to
select the type of hardware you
want to install. Scroll down the
list to highlight “PCMCIA socket”
(see Fig. 25) and click “Next.”

Fig. 25

J. Windows will provide you with a
list of Manufacturers and, to the
right of that window, a list of
Models. Find “(Standard PCMCIA
drivers)” under “Manufacturers”
and click on that choice. “PCIC or
compatible PCMCIA controller”
will appear, highlighted, to the
right (see Fig. 26). Click “Next.”

Fig. 26

K. Windows will then inform you of
the setting it is assigning to your
new hardware. Click “Next.”

L. Windows will advise you that
your new device is now installed
and might ask you if you want 32-
bit support. You probably do if
you have more than one PCMCIA
slot. Click Finish.

M. If you did not already have 32-bit
support enabled, you will now be
prompted through a series of
windows to enable 32-bit sup-
port. If you are not prompted for
this, please skip to step P.

N. You will be asked if you are using
a PC card to install windows, (we
assume you are not), answer “No”
and click “Next.”

O. You will now be asked: “Do you
want to review your system files
and select real-mode PC card
drivers so Windows can disable
them?” Select “No” and click
“Finish.”

P. Windows will prompt you to click
“Finish” to enable 32-bit support.
Click “Finish” and follow the
instructions to turn your com-
puter completely off.

Q. Check to ensure your PSA-200
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Video Capture card is installed
and turn on your computer.

R. You should now be able to run
the PSA-200 software.

8. Check for hardware conflicts. By run-
ning the Windows Hardware Conflict
TroubleShooter, Windows will help
you identify and resolve conflicts be-
tween your PSA-200 Video Capture
card and other devices in your system.
A. Enter into the Control Panel and

then into the “Help Topics” menu
listed at the top of that window.

B. Scroll to the end of that list to
“Trouble-shooting” and double
click on that icon to expand the
list.

C. Scroll down and highlight “If you
have a hardware conflict”. Click
on “Display”.

D. Windows will now guide you
through a set of instructions to
determine and correct any hard-
ware conflicts that might be
interrupting your systems perfor-
mance.

If you are still unable to initialize the
PCMCIA card, please contact our factory.

Hardware

No power to camera

Check power adapter connections. If there
is still no power, verify that the power
adapter indicator is lit. If the power adapter
is working, check the camera cable connec-
tions, and the “Y” cable connections. If there
is still no power, the camera or camera cable
may need repair. Call us for technical sup-
port.

Camera viewfinder is dark but camera
power indicator light is on

Make sure the camera lens cap is removed
from the camera lens. If the viewfinder is
still dark, make sure the camera is receiv-
ing at least five foot-Lamberts of light. If the
viewfinder is still dark, the camera may

need repair. Call us for technical support.

Computer message: Error from Capture
Hardware Driver

If any of the following errors appear when
starting the PSA program.
Exit the PSA program, shut down your com-
puter, check to insure that the PCMCIA card
is fully inserted in the card slot. Restart your
computer, and then restart the PSA pro-
gram. If the errors shown in Figures 27a-27c
appear again, call us for technical support.
If the errors shown in Figures 28a-28b ap-
pear, check to insure that the connector on
the “Y” cable is fully seated into the PCMCIA
card, check to insure that the camera cable
is fully seated into the camera and into the
“Y” cable. If the errors shown in Figures 28a-
28b appear again call us for technical sup-
port. If you cannot fix the problem, call us
for technical support.

Fig. 27a

Fig. 27b

Fig. 27c
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Fig. 28a

Fig. 28b

Luminance values are off

If the Luminance values are off, they will be
off by a factor of 10. Check the Camera
Range (Settings in the Program menu).
Check to see if the neutral density filter is
attached to the camera lens if you have a
unit with the 30 - 300 foot-Lamberts (100 -
1000 cd/m2) option. (See the Program sec-
tion for details on correct operation of the
Camera Range settings.)

Computer message: Alignment Error!

Manually adjust the camera angle and the
camera zoom switch so that the image ap-
pears centered in the camera’s viewfinder.
Press or click on F3, Camera View. The im-
age should appear centered in the computer
display. Adjust the zoom switch on the cam-
era or the W / T with the mouse in “Camera
View” so the edges of the image are visible
in the computer display. Now press or click
on F2, Auto Align. If the error message in
Fig. 29 appears again, try using the Manual
Alignment function. If you cannot fix the
problem, call us for technical support.

Fig. 29

Computer message: Weave and Jitter
Warning - Screen luminance may be too
high/ low for accurate measurement

Verify that you have at least 6 to 18 foot-
Lamberts of light from the lamp house. If
you cannot fix the problem, call us for tech-
nical support.

Weave and Jitter measurements are not
constant

The initial period that the PSA takes to
sample the projected image is 30 seconds.
When this occurs, the Weave and Jitter read-
ings will be high or zero for a few seconds
until they are updated. This is an errone-
ous reading which is normal and should be
ignored. The Weave and Jitter function
should be left to run for two minutes in or-
der to obtain enough samples of the frame
to recognize samples of the film splice. The
film splice samples will then be discarded
automatically and will not be included in
the analysis. If you are having problems that
do not seem to be due to this, call us for
technical support.

Weave and Jitter measurements do not
seem to be accurate

Make sure the camera is zoomed in on the
small squares of the RP40 test pattern (see
Fig. 6). The camera should be aimed at the
center of the test pattern and the Analysis
Square (in the bottom left corner) should be
trained only on the small black and white
squares of the RP40 test pattern. Be sure that
the projector is properly focused on the im-
age. The pattern in the center of the screen,
generated by the Weave and Jitter test film,
cannot be used for analysis.  Zooming in or
out too far will cause errors in readings.


